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Chapter 1 : Student editing feedback in OneNote - Microsoft Community
However, Jody Shipka notes something essential with regard to revision: surface changes--what lots of teachers call
"editing" and "peer editing"--is not "revision" (just as "peer editing" is not the same thing as "peer feedback"). Like other
researchers interested in revision, Shipka focuses on "deep revision," or a.

This article summarizes the basic tasks and commands to help get you started with OneNote Online. When
signed into OneDrive, navigate to the folder where you want to create the new notebook for example,
Documents. When prompted, enter a name for the new notebook. For best results, use a meaningful name that
describes the type of notes that the notebook will contain. Sections contain the pages in your notebook on
which you take notes. In the Section Name dialog box, type a meaningful description for the new section, and
then click OK. As soon as your first section and page are created, you can continue editing in your browser
window or click Open in OneNote on the top menu bar to switch to the full OneNote app installed on your
computer or device. Type or write notes in the browser OneNote Online lets you edit notes in your browser by
typing anywhere on its pages. In addition to typing and formatting text, you can also add images, tables, and
inserted files in your notes. Add links Whenever you type text that OneNote Online recognizes as a link also
known as a hyperlink , it automatically formats it as one. For example, if you type www. In this example,
clicking the link will open the OneNote website in your browser. You can also manually insert links into your
notes by doing the following: Select the text you want to link. Insert pictures With OneNote Online, you can
easily insert pictures into your notes. On any page, put the cursor where you want to insert the picture. Click
Insert and then do one of the following: Click Picture to insert a picture file from your computer. Click Online
Pictures to search for and insert pictures from Bing Images. The license filter in Bing can help you choose
which images to use. Draw a table Tables are a great way to organize information in your notes. To create a
table in OneNote Online, start by drawing a simple grid. Move the mouse pointer over the grid to select the
table size you want, and then click the left mouse button to create the table. For example, selecting a 4x6 table
would create a table with 4 columns and 6 rows. To quickly modify a table or any of its parts, click in any
table cell, and then click the Layout tab that appears on the ribbon. The table tools you find here let you insert
and remove rows and columns, select cells and cell ranges, show or hide table borders, and align table cells the
way you want. To select or modify parts of a table quickly, right-click PC or Control-click Mac any cell or a
selected range of cells, and then click the Table options at the right of the menu that appears Cell Shading,
Insert, Delete, or Select. Add more pages For more room in any section of your notebook, you can add as
many pages as you need. Type a title into the heading area at the top of the page, and then press Enter. To
change the order of your pages in the list, click and drag any page name to a new position. Add more sections
To better organize your notebook into different categories, you can add as many sections as you need. To
change the order of your sections in the list, click and drag any section name to a new position. This frees your
mind to let you think about your projects, thoughts, and ideas instead of thinking about your computer files.
Share notes online Your notebook is stored online, so you can easily share it with others for viewing or
editing. Near the top right corner in OneNote Online, click Share. Do either of the following: Click Invite
people to share the notebook with others. Enter their email addresses and a quick welcome note. To share a
notebook that others can modify, make sure Recipients can edit is displayed. To share a notebook for viewing
only, make sure Recipients can only view is displayed. Click the blue text to change the current setting. Click
Get a link to create a link to the current notebook that you can manually copy and paste in an email, blog post,
or Web page. In the Choose an option list, select View only or Edit to set the permissions level, and then click
Create link. Work together in a notebook Working together in a notebook is a good way to brainstorm ideas or
do research for a group project. Expand your Office skills.
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Upload and Download Files. The basics on adding your content to Box. Stay Organized in Box. Mark, sort, and easily
find your files. Work Together in Box.

Peer review can be used for different class projects in a variety of ways: Teach students to use these three
steps to give peer feedback: Explain that starting with something positive makes the other person feel
encouraged. You can also use Peer Edit With Perfection Tutorial to walk through the feedback process with
your students. The peer editor can mark spelling and grammar errors directly on the piece of writing. Teach
students what constructive feedback means providing feedback about areas that need improvement without
criticizing the person. Feedback should be done in an analytical, kind way. Model this for students and ask
them to try it. The Peer Editing Guide offers general advice on how to listen to and receive feedback, as well
as how to give it. For younger students, explain that you need helpers, so you will show them how to be
writing teachers for each other. Have the student return, and ask those questions. Model active listening by
repeating what the student says in different words. For very young students, encourage them to share personal
stories with the class through drawings before gradually writing their stories. Create a chart and display it in
the classroom so students can see the important steps of peer editing. For example, the steps might include:
Read the piece, 2. Say what you like about it, 3. Ask what the main idea is, 4. Make the chart gradually longer
for subsequent sessions, and invite students to add dialogue to it based on what worked for them. Take note of
which students work well together during peer review sessions for future pairings. Consider having two peer
review sessions for the same project to encourage more thought and several rounds of revision. Have students
write a class book, then take turns bringing it home to read. Encourage them to discuss the writing process
with their parents or guardians and explain how they offered constructive feedback to help their peers. Using
peer review strategies, your students can learn to reflect on their own work, self-edit, listen to their peers, and
assist others with constructive feedback.
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Standard Disclaimer: Please note that the OneNote Suggestion Box is moderated and is a voluntary participation-based
project. If your submission is not a product feature suggestion, it may be removed.

Members of the group use the Microsoft Word editing and markup tools to note errors and to provide feedback
and suggestions. The marked-up document is then returned to the writer. This article describes how to use the
Microsoft Word editing and markup tools for that purpose. If you only want to use the basic editing and
feedback tools, there is a quick-start summary at the end of this article. Click here to go to the quick start
summary. To get started, carry out the following steps: Customize your user information. This will tell the
writer who made the editorial comments. From the Tools men, select Options. Then select User Information.
Enter the name you want to be displayed with your edits in the Name box. Display your Markup Icons on the
Toolbar. This will make all the markup options readily available on the Toolbar. From the View menu, select
the Toolbars option. Then, select the Reviewing option to turn it on. When the Reviewing option is on it will
have a check next to it. The tracking options will then appear on your Toolbar. They are the little yellow icons.
One has a left arrow, another a right arrow, and a third an "X" on top of it, etc. That whole row of icons is
related to the Markup, Tracking, and Reviewing features of Word. Put your cursor over each icon to display its
function. Select your Markup Display Options. This allows you to determine the way your edits and comments
will be displayed when you are marking up a document. From the Tools menu, select Options. Then select
Track Changes. Choose the way you want your corrections to be displayed, i. Next, check the Use Balloons in
Print and Web option the comment balloons will only be displayed when you are in Web Layout or Print
Layout mode - these are options under the View menu and the Show lines Connecting to Text option. Finally,
select Left Border for the Changed Lines option. Marking up a Document 1. Turn on the Tracking function.
You will have to do this each time you want to markup a document. Either turn tracking on by going to the
Toolbar and clicking on the little yellow icon that looks like a document with red text. When you are finished
marking up a document be sure to press the key combination again or the icon on the Toolbar to turn tracking
off. You will know that the tracking option is turned ON if you see the letters TRK in the status line at the
bottom of the screen. You can also accept and delete Reviewer edits in this way. Once the tracking option has
been turned on, any changes you make to the document will be shown "in the color you have selected" and as
"balloons" in the right margin. The "balloons" will only show up on the right side of the text when you are in
Print Layout, otherwise they will show up in a box at the bottom of the screen. To get into Print Layout, open
the View menu and select Print Layout before you start marking up a document. Making Edits and Inserting
Comments To display the edits that you make in a document you must have Markup turned on. To do this,
select the Markup option from the View menu. To make an edit, just click the cursor where you want to make
the change and start typing. If you want to delete something, just do it. The program will mark the changes in
color as you make them and a balloon will appear in the right margin indicating the change this happens only
if you make a comment or delete something - added words will just appear in the text in color. If you want to
make a comment about something in the text, use the mouse to highlight the text you are referring to and then
go to the Toolbar and click on the little yellow icon with the star in the upper left hand corner. If you put your
mouse cursor over that icon it will say, New Comment. A balloon will appear in the right margin of the
document in which you can type your comment.
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I think all of the answers given miss the whole point of the question. I believe the question is the same one I have. We
want to be able to EDIT the spreadsheet/document INSIDE OneNote not click a button, wait for the associated program
to load, then wait for it to load the item, then edit INSIDE THAT program, then save and wait for the PREVIEW to
update.

IBM Notes resembles a web-browser in that it may run any compatible application that the user has
permission for. IBM Notes provides applications that can be used to: A Domino application-developer can
change or completely replace that application. Software developers can build applications to run either within
the IBM Notes application runtime environment or through a web server for use in a web browser, although
the interface would need to be developed separately unless XPages is used. Notes can access both local- and
server-based applications and data. The system can retrieve recipient addresses from any LDAP server,
including Active Directory , and includes a web browser, although it can be configured by a Domino
Developer to launch a different web browser instead. IBM Notes can be used with IBM Sametime
instant-messaging to allow to see other users online and chat with one or more of them at the same time.
Beginning with Release 6. Since version 7, Notes has provided a Web services interface. A design client, IBM
Domino Designer , can allow the development of database applications consisting of forms which allow users
to create documents and views which display selected document fields in columns. In addition to its role as a
groupware system email, calendaring, shared documents and discussions , IBM Notes and Domino can also
construct "workflow"-type applications, particularly those which require approval processes and routing of
data. Since Release 5, server clustering has had the ability to provide geographic redundancy for servers.
There are different supported versions of the IBM Domino server that are supported on the various levels of
server operating systems. Usually the latest server operating system is only officially supported by a version of
IBM Domino that is released at about the same time as that OS. IBM Domino has security capabilities on a
variety of levels. The authorizations can be granular, down to the field level in specific records all the way up
to 10 different parameters that can be set up at a database level, with intermediate options in between. Users
can also assign access for other users to their personal calendar and email on a more generic reader, editor, edit
with delete and manage my calendar levels. The generalized nature of this feature set it apart from
predecessors like Usenet and continues to differentiate IBM Notes from many other systems that now offer
some form of synchronization or replication. It is available for any data in any application that uses Notes
Storage Facility. No special programming, tagging, or other configuration is required to enable replication.
IBM Domino servers and Notes clients identify NSF files by their Replica IDs, and keep replicate files
synchronized by bi-directionally exchanging data, metadata, and application logic and design. There are
options available to define what meta-data replicate, or specifically exclude certain meta data from replicating.
Replication between two servers, or between a client and a server, can occur over a network or a point-to-point
modem connection. Replication between servers may occur at intervals according to a defined schedule, in
near- real-time when triggered by data changes in server clusters, or when triggered by an administrator or
program. The client synchronizes any changes when client and server next connect. Local replicas are also
sometimes maintained for use while connected to the network in order to reduce network latency. Replication
between an IBM Notes client and Domino server can run automatically according to a schedule, or manually
in response to a user or programmatic request. Since Notes 6, local replicas maintain all security features
programmed into the applications. Earlier releases of Notes did not always do so. Early releases also did not
offer a way to encrypt NSF files, raising concerns that local replicas might expose too much confidential data
on laptops or insecure home office computers, but more recent releases offer encryption, and as of[ when?
Security[ edit ] IBM Notes was the first widely adopted software product to use public key cryptography for
clientâ€”server and serverâ€”server authentication and for encryption of data. Until US laws regulating
encryption were changed in , IBM and Lotus were prohibited from exporting versions of Notes that supported
symmetric encryption keys that were longer than 40 bits. In , Lotus negotiated an agreement with the NSA that
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allowed export of a version that supported stronger keys with 64 bits, but 26 of the bits were encrypted with a
special key and included in the message to provide a "workload reduction factor" for the NSA. This
strengthened the protection for users of Notes outside the US against private-sector industrial espionage , but
not against spying by the US government. Some governments objected to being put at a disadvantage to the
NSA, and as a result Lotus continued to support the bit version for export to those countries. IBM Notes and
Domino also uses a code-signature framework that controls the security context, runtime, and rights of custom
code developed and introduced into the environment. Notes 5 introduced an execution control list ECL at the
client level. The ECL allows or denies the execution of custom code based on the signature attached to it,
preventing code from untrusted and possibly malignant sources from running. Notes and Domino 6 allowed
client ECLs to be managed centrally by server administrators through the implementation of policies.
Administrators can centrally control whether each mailbox user can add exceptions to, and thus override, the
ECL. Database security[ edit ] Every database has an access control list ACL that specifies the level of access
a user or a server can have to that database. The names of access levels are the same for users and servers.
Only a user with Manager access can create or modify the ACL. To set an ACL, the Manager selects the
access level, user type, and access level privileges for each user or group in a database. Default entries in the
ACL can be set when the Manager creates the database. The manager can also assign roles if the database
designer determines this level of access refinement is needed by the application; for instance, when users
within the same group must be provided different levels of access. Programming[ edit ] IBM Notes and
Domino is a cross-platform, distributed document-oriented NoSQL database and messaging framework and
rapid application development environment that includes pre-built applications like email, calendar, etc. This
sets it apart from its major commercial competitors, such as Microsoft Exchange or Novell GroupWise , which
are purpose-built applications for mail and calendaring that offer APIs for extensibility. Originally, replication
in Notes happened at document i. With release of Notes 4 in , replication was changed so that it now occurs at
field level. A database is a Notes Storage Facility. Every note has a UniqueID that is shared by all its replicas.
Every replica also has a UniqueID that uniquely identifies it within any cluster of servers, a domain of servers,
or even across domains belonging to many organizations that are all hosting replicas of the same database.
Each note also stores its creation and modification dates, and one or more Items. There are several classes of
notes, including design notes and document notes. Design notes are created and modified with the Domino
Designer client, and represent programmable elements, such as the GUI layout of forms for displaying and
editing data, or formulas and scripts for manipulating data. Document notes represent user data, and are
created and modified with the Lotus Notes client, via a web browser, via mail routing and delivery, or via
programmed code. Document notes can have parent-child relationships, but IBM Notes should not be
considered a hierarchical database in the classic sense of information management systems. Notes databases
are also not relational , although there is a SQL driver that can be used with Notes, and it does have some
features that can be used to develop applications that mimic relational features. IBM Notes does not support
atomic transactions, and its file locking is rudimentary. IBM Notes is a document-oriented database
document-based, schema-less, loosely structured with support for rich content and powerful indexing
facilities. This structure closely mimics paper-based work flows that IBM Notes is typically used to automate.
Items represent the content of a note. Every item has a name, a type, and may have some flags set. A note can
have more than one item with the same name. Flags are used for managing attributes associated with the item,
such as read or write security. Items in design notes represent the programmed elements of a database. For
example, the layout of an entry form is stored in the rich text Body item within a form design note. Items in
document notes represent user-entered or computed data. An item named "Form" in a document note can be
used to bind a document to a form design note, which directs the IBM Notes client to merge the content of the
document note items with the GUI information and code represented in the given form design note for display
and editing purposes. However, other methods can be used to override this binding of a document to a form
note. The resulting loose binding of documents to design information is one of the cornerstones of the power
of IBM Notes. Traditional database developers used to working with rigidly enforced schemas, on the other
hand, may consider the power of this feature to be a double-edged sword. IBM Notes applications
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development uses several programming languages. Formula and LotusScript are the two original ones.
LotusScript is similar to, and may even be considered a specialized implementation of, Visual Basic, but with
the addition of many native classes that model the IBM Notes environment, whereas Formula is similar to
Lotus formula language but is unique to Notes. With Release 5, Java support was greatly enhanced and
expanded, and JavaScript was added. While LotusScript remains a primary tool in developing applications for
the Lotus Notes client, Java and JavaScript are the primary tools for server-based processing, developing
applications for browser access, and allowing browsers to emulate the functionality of the IBM Notes client.
As of version 6, Lotus established an XML programming interface in addition to the options already available.
The Java toolkit is the least mature of the three and can be used for basic application needs. Database[ edit ]
IBM Notes includes a database management system but IBM Notes files are different from relational or object
databases because they are document-centric. Document-oriented databases such as IBM Notes allow multiple
values in items fields , do not require a schema , come with built-in document-level access control, and store
rich text data. IBM Domino 7 to 8. Whereas the temptation for relational database programmers is to
normalize databases, Notes databases must be denormalized. RDBMS developers often find it difficult to
conceptualize the difference. Since Lotus Notes 8. The benefits of this data structure are: No need to define
size of fields, or datatype; Attributes Notes fields that are null take up no space in a database; Built-in full text
searching. No relevant configuration settings are saved in the Windows Registry if the operating system is
Windows. Some other configuration options primary the start configuration is stored in the notes. Use as an
email client[ edit ] IBM Notes is commonly deployed as an end-user email client in larger organizations, with
IBM claiming a cumulative million[ citation needed ] licenses sold to date. When an organization employs an
IBM Domino server, it usually also deploys the supplied IBM Notes client for accessing the IBM Notes
application for email and calendaring but also to use document management and workflow applications. As
IBM Notes is a runtime environment, and the email and calendaring functions in IBM Notes are simply an
application provided by IBM, the administrators are free to develop alternate email and calendaring
applications. It is also possible to alter, amend or extend the IBM supplied email and calendaring application.
There are several spam filtering programs available including IBM Lotus Protector , and a rules engine
allowing user-defined mail processing to be performed by the server. Comparison with other email clients[
edit ] IBM Notes was designed as a collaborative application platform where email was just one of numerous
applications that ran in the Notes client software. These two factors have resulted in the user interface
containing some differences from applications that only run on Windows. Furthermore, these differences have
often remained in the product to retain backward compatibility with earlier releases, instead of conforming to
updated Windows UI standards. The following are some of these differences.
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Student editing feedback in OneNote Whenever I provide students with feedback on assignments they complete within
the personal section of their Class Notebook, they are able to simply delete or change the comments that I leave.

Note that formative feedback are 1 and 6. Having a feedback-rich classroom is one of the very best things you
can do if you want to promote learning. So what, then, are the qualities of helpful feedback? It is formative â€”
it helps learners get better at a task or increases their understanding. It is descriptive, goal referenced and
directed. As teachers, our goal should be to prepare students to give feedback that helps a writer understand:
What they accomplished descriptive. What they were asked to accomplish goal referenced. What they must do
next goal directed. Of course, we help our students when our own feedback has these characteristics. But how
can we help our students learn to provide better feedback? Three specific things we can do include: Providing
ample opportunities for deliberate practice in giving feedback. Constructing effective review prompts. But
once students have the basics of giving helpful feedback, how do we help them use feedback they receive?
Part 4 Teaching Revision: Therefore, it is necessary to move beyond simply asking students to revise. We
must teach revision. To view this video please enable JavaScript, and consider upgrading to a web browser
that supports HTML5 video One approach to teaching revision is to teach revision planning. The idea behind
revision planning is to ask students to think and reflect on their writing and feedback and to do so in a way that
allows teachers and peers to see that thinking. Asking students to create a plan for their revision is also the
best way to move students toward actually revising. Revision planning entails three meta-cognitive moves that
lead to improvement: Selection, or choosing the specific feedback that a writer plans to use to revise.
Prioritization, or ordering feedback from most important to least important. Reflection, or student thinking
about their writing and revision. Supporting and practicing this meta-cognitive work is necessary to ensure
revision and learning. Eli Review, for example, includes a set of revision tools designed specifically to help
students select helpful feedback, create prioritized lists, and reflect on their plans. However, 30 years of
research into learning and writing is conclusive: And there are numerous waysâ€”through technology, peers,
and other teachersâ€”that students can get the feedback they need. Typically, the majority of time in an
assignment sequence is spent on writing and discussion, leaving less time for feedback and revision. Making
Time with Rapid Iterations One way to make space in curriculum for more feedback and revision is to change
assignment sequencing. If we were to roll out the "typical" donut above, this is what an assignment sequence
might look like: Beginning of project The student is bright-eyed and full of ideas. Mid-way through project
The student is still writing the first draft. In sequences like this, a lot of time is invested developing a
fully-functional version of a text. Some consequences of this sequence include: Less time for feedback and
revision. Less openness to revision because of impending deadlines. Less openness to revision because of
unwillingness to throw out substantial amounts of text. Contrast the typical writing-intensive sequence to a
workflow like this, where the mantra is "review early and review often": Here, in the same amount of time,
review and revision are treated as co-equal components and more closely resemble the iterative process
writing studies has advocated for 30 years. There are numerous advantages to a more iterative writing process:
Writers get feedback at the earliest stage of the process. Anything of any size can be reviewed - titles, theses,
outlines, paragraphs, etc. Greater confidence that later drafts meet criteria. Likelihood of plagiarism reduced if
instructors can watch ideas evolve from their origin. Less investment in early drafts and ideas and more
willingness to incorporate feedback and revise. There are other ways to make room for the teaching and
coaching of feedback and revision, particularly in the way that reviews are designed and results are reported.
Part 6 Discussion, Resources, and Next Steps Key Takeaways This module has made the case for why writing
instruction focused on feedback and revision stands a better chance of producing not just better writing but
also better writers. Feedback is essential to learning and is one the strongest influences on achievement.
Revision is one of the key differences between expert and novice writers. Students have to be taught how to
give formative, timely, and goal-referenced feedback. Instructors can make time for more review and revision
with rapid write-review-revise iterations. Questions for Further Discussion How can feedback drive formative
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assessment? How can it help achieve teaching and learning goals? Does your institution have an improvement
plan, and if so, how might those goals line up with a feedback-centered curriculum? Writing is usually
associated with language arts, but what role does writing play in other subjects, and how might feedback play
a role in learning in those fields? How might your teaching change if you had performance data during the
academic year, even after individual exercises, rather than post-year standardized test data? Next Steps and
Additional Materials Explore additional entries in this four-part Teacher Development Series to take these
ideas further, or find examples of Eli Review in action and how to use it effectively. Curriculum materials and
activities: Framing Feedback and Revision: Reading materials for students: Student Development Series readings on feedback and revision for students. Sample Teaching Material - examples of feedback-centric
lessons and projects. Technology How Eli Review Works - an overview of how the app supports peer
learning. Resources Eli Review Blog - posts about feedback or specific teaching examples.
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If it's a positive feedback, it cannot be revised. If it's a negative feedback, it can, but the process is initiated by the seller.
The seller sends you the revision request, and you revise it.

Track progress and consolidate comments. When reviewers click the URL in the email invitation from their
computer, they can easily provide their feedback in a browser without having to sign in or install any
additional software. You can use the service to share PDF files for review in one of the following ways: The
sharing options are displayed in the right pane. The computer must be connected to the Internet to start a
shared review in Acrobat. The Name and Message fields are just like the ones you use for sending an email
and appear to your recipients in the same way. Enter the desired information. If you want to set the review
deadline, select Set Deadline. Specify the time, select the date, and click Done. Reviewer experience The
reviewers receive an email invitation with a link to the review PDF. They can use the commenting tools to add
comments to the PDF. For more information, see Participating in a PDF review. Send an anonymous or public
link in an email An anonymous or public link makes the files accessible to anyone who clicks the link. Follow
the steps below to create a review link, and share it using your email client. The selected file is uploaded to the
Document Cloud, and a public link is created. You cannot set a deadline or reminder when you create a public
link and share the file for review. To copy the review link, click Copy Link. Share the review link with the
reviewers in an email. When they click the link or the Review button in the invitation, the PDF opens in a web
browser. The Preferences dialog box is displayed. In the left pane, click Reviewing. The Send for Comments
toolset is displayed in the secondary toolbar. In the secondary toolbar, click Send For Shared Commenting. If
prompted, select a PDF file that you want to send for shared review. Select the way you want to collect
comments from your reviewer and click Next. Select how you would like to host the shared review file and
specify the location. If all recipients are within a local area network, network folders and SharePoint servers
are the best choices for a comment server. Network folders are generally the cheapest and most reliable. If
your recipients work behind a firewall and all have access to a common server, you can use your own internal
server location, such as a Microsoft SharePoint site. WebDAV servers web servers that use the WebDAV
protocol are best used only if your reviewers are outside a firewall or a local area network. An Alternative to
Acrobat. Choose a delivery and collection method. On the email screen, specify the following settings as
needed: Delivery Method Click to specify a different delivery and collection method from the one that is
currently selected. To, Cc Enter the email addresses of your reviewers. Insert a semicolon or a return after
each address. Click the To or Cc button to select email addresses from your email application address book.
Subject, Message Preview and edit the email subject and message as needed. Acrobat saves any changes you
make and displays them the next time you send a document for review. To use the default email message,
click Reset Default Message. Review Deadline Click to specify a different date or no deadline. After the
review deadline expires, reviewers cannot publish comments. If the review deadline expires while a reviewer
has the document open in Acrobat, then the reviewer can publish comments before closing the document. The
shared PDF that you send includes the Annotation and Drawing Markups panels, and instructions in the
document message bar. Start an email-based review Available in: After initiating a shared review, you can
also start an email-based review with the same PDF. Before you start an email-based review, make sure that
your email application or webmail account is configured to work with Acrobat. If prompted, enter information
in the Identity Setup dialog box. The PDF that you specify becomes the master file. Merge the comments you
receive from reviewers into this file. Specify reviewers by typing their email addresses. Insert a semicolon or a
return between each address. Click Address Book to select email addresses from your email application or
webmail address book. Preview and edit the email invitation as needed, and then click Send Invitation. Select
an email client to send the invite and click Continue. A copy of the PDF is sent to the reviewers as an
attachment. When this PDF attachment is opened, it presents commenting tools and instructions. Steps to
merge comments After you receive comments from reviewers, you can merge the comments into the master
PDF. After a reviewer sends you comments, open the attached file in your email application. First merge these
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comments into your copy of the PDF. Then send the comments; see Send comments in email. Merged
comments retain the original author name. If you initiated the review, the Merge Comments dialog box
appears. Select one of the following options: Yes Opens the master copy of the PDF and merges all comments
into it. After comments are merged, save the master PDF.
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If possible, do your editing and proofreading in several short blocks of time. Your concentration may start to wane if you
try to proofread the entire text at one time. If you're short on time, you may wish to prioritize.

All users have the ability to revert to a previous version of a page. One edit reversion The undo link is located
at the end of the line for each edit If you would like to undo just one edit you simply need to: Go to the history
of the page Next to the edit summary is a link that says Undo, click on this and you will be brought to the edit
window, which shows the difference in edits on top. Leave an edit summary and then hit save, and the edit
will be un-done. Multi edit reversion This allows you to return to a specific version of the page, undoing
multiple edits. Go to the history of the page Click on the time and date of the earlier version you want to revert
to. Once you are sure the revision you are looking at is good, save the page. Be sure to add the word "revert"
to the edit summary often abbreviated as "rv". Notes You should always explain why you are reverting an
article. If your reasons for reverting are too complex to explain in the edit summary, explain it on the talk
page, and add "See talk page" in the edit summary. High-frequency reversion wars make the page history less
useful, make it hard for other people to contribute, and flood recent changes , followed pages and Wiki
Activity. Assume good faith , communicate the problem you see in their edit, and you will almost always be
able to find a compromise that allows editing on the article to move forward without further disruption. What
is rollback, and how do I use it? The rollback link is located before the undo button Administrators , Content
Moderators and users with rollback rights have an extra "rollback" link on history , diff and user contribution
pages that lets them revert vandalism faster, without the extra steps of going to the page history and opening
an earlier revision. Clicking on the link reverts to the last edit not authored by the user concerned. An edit
summary will be added automatically stating that a reversion was made, and the edit will be marked as minor.
Only use this for reverting vandalism. It should not be used to revert an edit that you merely disagree with. If
between loading the user contributions page and pressing rollback, someone else has edited or rolled back the
page already, the message "Rollback failed" will display with an explanation of the problem. If the page has
been created by a malicious user and nobody else has edited the page, clicking the rollback link gives the
message "Cannot revert edit; last contributor is only author of this article". In this case delete the page, or
replace the content with something appropriate to the page name if possible. Can I hide flood vandalism
reverts from recent changes? A "flood" occurs when a vandal makes edits to many pages very quickly in an
attempt to make the recent changes page unusable, by filling it with their own nonsense edits and the
reversions which fix the damage. In these cases, admins can choose to hide vandalism from recent changes. To
do this, add? When the rollback links on the contributions list are clicked, the revert, and the original edit that
you are reverting will both be hidden from the default recent changes display. The edits are not hidden from
contributions lists, page histories or followed pages. The edits remain in the database and are not removed, but
they no longer flood recent changes. The aim of this feature is to reduce the annoyance factor of a flood vandal
with relatively little effort.
Chapter 8 : Starting a PDF review, Adobe Acrobat
To hear the pitch of the note while moving, activate the speaker icon (Acoustic Feedback) on the toolbar. Score Layout
and Printing (Cubase Pro only) Entering and editing notes.

Chapter 9 : How to Write an Email Asking for Feedback - wikiHow
Chart notes that have been signed can no longer be edited or deleted; however, you can add an amendment/addendum
to the note. Within your signed encounter, click the Add Addendum button in the top right corner.
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